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Fitrix Report Writer User Reference

Welcome to the Fitrix Report Writer User Reference. This manual is 
designed to be a focused step-by-step guide. We hope that you find all 
of this information clear and useful.
All of the screen images in this document are show with the products 
using the character user interface. While the Fitrix Rapid Application 
Development (RAD) Tools operate in character mode only,  the soft-
ware applications created by the RAD tools offer the option of being 
viewed in a graphic based Windows (or X11) mode as well as the char-
acter mode shown. Examples of graphic based product viewing modes 
are shown below in Example 1 and Example 2.

Example 1: Menu Graphical Windows Mode
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Here is another example:

Example 2: Data Entry Graphical Windows Mode 

Displaying our products in graphic mode, as shown in Example 1 and 
Example 2, is customary for many Fitrix product users. 
However, your viewing mode is a user preference. Changing from 
character based to graphical based is a product specific procedure, so if 
you wish to view some applications in character mode, and some in 
graphical mode, that can be done as well. 
If you have any questions about how to view your products in graphical 
mode, please consult your Installation Instructions or contact the Fitrix 
helpdesk at 1(800)374-6157. You can also contact us by email: 
support@fitrix.com. Please be prepared to offer your name, your com-
pany, telephone number, the product you are using, and your exact 
question.  
We hope you enjoy using our products and look forward to serving you 
in the future.

Thank You,
Fourth Generation
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Documentation Conventions
Some information is difficult to convey in text, such as a series of keystrokes or a 
value you supply. This Technical Reference uses several conventions to convey 
information that has special meaning. These conventions use different fonts, for-
mats, and symbols to help you discern commands, program code, file names, and 
keystrokes from other text.

Text Format Meaning Example

Courier Bold Represents command syntax 
in addition to variable and 
file definitions.

fg.writer 

Courier Bold 
Italic 

Represents text you should 
replace with the appropriate 
value. 

-r report-name

Courier Represents commands; code; 
file, directory, table, and col-
umn names; and system 
responses.

report.ifg
Makefile
standard
rtmargin 

Small Courier Represents program code or 
text in a file.

output
    top margin 3
    bottom margin 3
    left margin 3
    right margin 77
    page length 66

Symbol Meaning Example

[ ] Represents optional com-
mand flags or arguments.

fg.report [-f] 

{ } Represents a mandatory 
choice of options.

{one|two|three}

| Delimits choices. -y|-n 

... Represents command argu-
ments that can be repeated.

filename... 
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When not part of an explicit instruction, single keyboard characters, field values, 
and prompt responses are shown in uppercase. For example:

Choose Y or N.
Enter an A for ascending or D for descending.
Press Q to quit.

Named keys are shown in uppercase and enclosed in brackets, for instance:

[TAB]
[F1]
[ESC]
[ENTER]

When a series of keys should be entered at the same time, they are shown with a 
hyphen connecting them. For example:

To close the menu, press [CTRL]-[d].

Some keys differ from keyboard to keyboard. This manual mentions the [ENTER] 
and [DEL] keys, but both may be missing from your keyboard. Hardware manufac-
turers give different names to keys that perform the same function. 

Although many similar versions of UNIX and XENIX can run INFORMIX-4GL 
and the Fitrix Report Code Generator, this manual refers to all of them with the sin-
gle term of UNIX.

Keys Common Variations

[ENTER] RETURN, RTRN, ↵
[ESC] STORE

[DEL] BREAK, CTRL C, CTRL BREAK
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1
Introduction

Fitrix Report Writer lets you create reports using information stored in an INFOR-
MIX-SQL database. This product lets non-technical users access information in 
complicated data structures without having to understand the complexities of writ-
ing SQL queries. Prompts take you through the report-writing process step by step, 
indicating all of the information that you must provide for a basic report.

This section covers the following topics:

n Report Writer Overview

n Report Writer Features

n User Reference Overview
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Report Writer Overview

The Report Writer’s menu system is designed to lead you through the process of 
creating a new report. Select the New Report option from the File pull-down menu, 
and you are led through the steps necessary for selecting the information for the 
report. You do this by first specifying the main table for the report. The main table 
should supply the detail of the report (when choosing the main table for your report, 
use the table that will be supplying most of the data for the report). Then name the 
report, choose the columns you want to appear, and arrange the columns in any 
order. You can further modify the report using the various Report and Options pull-
down menu selections.

The database description facility built into the Report Writer allows you or your 
database administrator to interact with your SQL database via friendly and easy-to-
understand menus, lists, and forms. These features allow you to attach familiar 
(easy-to-remember) names to technical database tables and column names. Instead 
of having to remember what table stgcntrc is, you can refer to it by a more 
descriptive name such as General Ledger Defaults.

The database description facility also lets you define and modify database table 
relationships. With this facility, you can quickly view the relationships previously 
defined between tables, and you can define new relationships.

You can also create data groups that allow you to group related tables and columns 
together. Specifying a data group limits the tables you use from your database. This 
lets you create your reports more quickly since you do not have to search through 
the entire database to locate the desired tables. For example, you may want to 
define an Accounts Payable group that contains all of the tables that relate to AP. 
Then, whenever you create an AP report, only the tables related to AP appear.
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Report Writer Features

The Report Writer is loaded with dozens of great features, which make report 
building, formatting, editing, and printing quick and easy. 

n WYSIWYG Report Building

n Online Help

n Context-Sensitive Help

n User Definable Help Text 

n Familiar and Technical Table and Column Names 

n Query Failure Detection

n Pull-Down Menus

n Cut and Paste Capability

n Hidden Report Fields

n Default Format Styles

n 256-Column Reports

n Automatic Summary Reports

n Rebuild Capability for Reformatting Manual Edits

n Definable Format Styles

n Flexible Selection Criteria

n Related Table Data Groups

n Standard and Outer Joins Between Table Relationships in Database

n Report Groups

n Reuseable Data Selection Criteria

n Data Posting to New Tables

n Masks for Form Alignment
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n Test Sections of Reports

n Page Breaks Before or After Report Groups 

n Compatible Lotus 1-2-3 Format

n Printer Lists

n Screen, Printer, Mail File, Fax, or Archive Report Output

n Complex Math Formula Capability

n Date Math

n Simple and Complex Arithmetic Calculations

n Subtotals and Grand Totals

n Calculations on Fields Used to Calculate Other Fields

n Unlimited Number of Reports 

n Report Security 

n Shared Reports

n Command Line or Menu Initiation
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User Reference Overview

This User Reference is designed to familiarize you with the Report Writer. The first 
two sections acquaint you with some of Report Writer’s menus and menu options. 
The next section takes you through the steps necessary to create a report. After that, 
the menu options and features are discussed in greater detail. The final section takes 
you through the creation of a more complex report.

1. Introduction: Introduces the Report Writer’s features and the Report Writer 
documentation.

2. Getting Acquainted: Explains how to start the Report Writer, how to use its 
pull-down menus, and how to create and use online help. Viewing program 
information is also discussed.

3. Creating a Simple Report: Walks you through the steps to create a basic 
report. 

4. Using the Report Writer: Details the prompts, menus, and dialog boxes you 
use when building reports. This section describes many of the elements that 
make up a report such as data groups, the main table, report formats, report 
descriptions, column selection, column grouping, column sorting, column sub-
totalling, and selection sets.

5. File Functions: Explains all the file functions including loading, saving, 
printing, and exiting the Report Writer.

6. Other Report Writer Features: Explains some other features such as creat-
ing report formats, manually editing the report, creating groups of reports, and 
deleting report characteristics.

7. Defining the Database: Explains how to set up your database definitions. 
Report Writer allows you to rename tables and columns, define online help for 
tables and columns, define data groups for related tables, and define table joins.

8. Creating a Complex Report: Takes you through the creation of a more 
complex report, using additional Report Writer features.

9. Appendix: Contains a glossary of terms, introduces the security features 
available for the Report Writer, and shows table/column schemes.
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2
Getting Acquainted

Because the Report Writer is designed to interact with you as you design reports, 
your first objective is to understand the Report Writer’s menu system and the report 
design process. This section introduces you to the Report Writer’s user interface 
and other general Report Writer features.

This section covers the following topics:

n General Overview

n Starting Report Writer

n Using Menus

n Report Writer Menu Options

n Using Zooms

n Viewing Program Information
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General Overview

You can build reports with Report Writer in a few quick steps. First you must build 
a Report Description. You build Report Descriptions by selecting the data you want 
your report to contain, giving your report a name, and designing the format for your 
report. Report Writer walks you through the Report Description process with a 
series of menus, prompts, and lists. 

Once a Report Description is built, you can attach a selection set to it. Selection sets 
determine the scope of your report. Without a selection set your report displays all 
information.

After you attach a selection set, or choose not to attach one, the Report Runner gen-
erates the SQL query that extracts and formats data from your database. When the 
Report Runner is finished, you can print your report.

PRINTED
REPORT

REPORT
DESCRIPTION

SELECTION
SETS

REPORT
RUNNER
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Starting Report Writer

In order to run Report Writer, the following conditions must be met:

1. Your $PATH variable must contain $fg/bin. You must set the $fg variable 
to point to the parent directory of the Report Writer program.

2. Your termcap must be Informix compatible. For Report Writer to run correctly, 
your termcap must be Informix compatible. If your termcap is set up incor-
rectly, Report Writer does not display boxes and window frames. If you have a 
termcap problem, see your system administrator or refer to your Informix docu-
mentation on termcaps. 

The Report Writer is run by typing the following at the UNIX prompt:

fg.writer [-dbname database-name] 

You can specify which database to load. Use the -dbname flag followed by the 
database name when you start Report Writer. If you do not specify a database, 
Report Writer defaults to the standard database.

The examples in this guide use tables specially made for demonstration and exam-
ples. In order for you to use these tables, you must merge them into the database 
that you want to use for your examples.

In this manual the demonstration tables were merged into the standard database. 
You can use whatever database you want. To put the demonstration tables into your 
database, type the following at the UNIX prompt:

mkdemo -dbname database-name 

The mkdemo script takes a few minutes to complete.

When creating demonstrations on separate databases, you may also need to merge 
Report Writer and library tables. To merge these tables, type:

mkwriter -dbname database-name 

mklib -dbname database-name 
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Using Menus 

The Report Writer interface uses pull-down menus. To open a pull-down menu use 
the arrow keys to highlight it and press [ENTER]. Or type the first letter of the pull-
down menu name (such as r for the Report pull-down menu). 

Each pull-down menu contains several options. To select an option, open the pull-
down menu, move the highlight with the arrow keys to the option you want, and 
press [ENTER]. Or type the first letter of the option’s name. 

Sometimes an exclamation point (!) precedes an option. An exclamation point 
means the option is not available. For instance, if no report is current, an exclama-
tion point precedes the Save the Report option.

An ellipse (...) or two greater than symbols (>>) follow some options. An option 
with an ellipse leads to another menu or entry form, for example, the Arrange Col-
umns option under the Report pull-down menu.
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An option with the greater than symbols leads to a list of selections, for instance, 
the Load a Report option under the File pull-down menu.
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Report Writer Menu Options

The Report Writer gives you the ease-of-use and intuitive design of pull-down 
menus to help you create report programs. This section discusses each Report 
Writer pull-down menu and shows the options in each menu.

File

The File pull-down menu lets you create, load, save, print, import and export 
reports, and exit.

Report

The Report pull-down menu lets you describe, edit, and rebuild your report. With 
the Report pull-down menu you can also choose, arrange, sort, and group the col-
umns in your report, and define selection sets.
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Delete

The Delete pull-down menu lets you remove reports, selection sets, report groups, 
report formats, printers, data groups, and table relationships.

Options

The Options pull-down menu lets you modify your report. With the Options menu, 
you can update format templates, column descriptions, and printer lists. You can 
also define data groups, groups of reports, and table relationships.
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Help

The Help pull-down menu displays a list of specific Report Writer topics. Selecting 
a topic displays a list of subtopics. Each subtopic contains Report Writer help infor-
mation. Context sensitive help is also available at any time by typing [CTRL]-[w]. 
For more information on using help, refer to "Using Online Help" on page 6-18.

Quit

The Quit pull-down menu lets you quit the Report Writer. If you attempt to quit 
before saving your report, a dialog box appears and prompts you to save your 
report.
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Using Zooms

The Report Writer features Zooms. Zooms give you more information on a particu-
lar field or menu option. A Zoom is available when the word Zoom appears in 
parenthesis near the upper right portion of the screen. Your cursor must be in a par-
ticular field or menu option for a Zoom to appear.

To activate a Zoom:

1. Position your cursor on a field or menu option.

2. Press [CTRL]-[z]. 

When a Zoom is avail-
able, the word Zoom
appears. 
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Viewing Program Information

Select the Acknowledgments option under the Help pull-down menu to view pro-
gram acknowledgments. These Acknowledgments display copyright and develop-
ment credits for the program.

Business:
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Creating a Simple 
Report

If you are like most users, you want to get started building reports quickly, without 
knowing all the details about the Report Writer right off the top. This section walks 
you through the steps to create a simple report program. If you want a fast introduc-
tion to the Report Writer, follow the steps outlined in this section.

This section contains the following topic:

n Creating a Simple Report
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Creating a Simple Report

Report Writer makes it easy to build simple, custom reports. The following section 
describes how to create a simple report, using one table. The steps to build a more 
complex report are discussed in "Creating a Complex Report" on page 8-1. 

Note

To use the demonstration tables shown in this manual, you must merge the dem-
onstration tables into your database. If the tables are not in your database, you 
must run the mkdemo script on the database you want to use. See "Starting 
Report Writer" on page 2-3.

To build a simple report:

1. Open the File pull-down menu.

2. Select the New Report option.
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The Choose a Data Group list appears.

3. Select Demo Data Set.

If the Demo Data Set does not appear, see the NOTE on the previous page. The 
Choose a Table list appears.

4. Select Customer Information for your main table.
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If you have any report formats defined, a list appears asking you to select a for-
mat. If the Select a Format list appears, press the [DEL] key to skip this option 
for now. For more on report formats see "Choosing the Report Format" on page 
4-5. If no formats are defined, the Report Writer goes directly to the Report 
Description form. 

The Report Description form contains all the main report definitions. It is here 
that you can specify the report name, data group, table name, table, selection 
set, and report format. Many of these options are already defined, but you are 
free to change them in this form. However, you cannot specify a different data-
base. The database can only be specified when you start Report Writer by using 
the -dbname flag.

5. Name your report Customer Listing.

6. Press [ESC] to store this name.

The Choose the Columns list appears. From this list you choose the columns 
you want to show on your report.
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7. Select all the columns.

You can select columns by pressing [ENTER]. Once you select a column, an 
asterisk appears in front of its name.

8. Press [ESC] to store your selections.

The Arrange Columns form appears from which you can specify the order the 
columns will appear on your report. For this report, leave the columns in their 
original sequence. 

9. Press [ESC] to store this sequence. 
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An image of your report appears in the background, and the Choose a Selection Set 
list appears.

For this report, do not use a selection set.

10. Press [DEL] to exit the Selection Set list. 

The File pull-down menu opens, so you can save or print your report. 

11. Select the Print Report option. 
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A prompt appears requesting you to save your report.

12. Press [ENTER] to save your report as Customer Listing. 

Once you save your report the Choose a Destination list appears.

13. Select the Display to Screen option. 

The Screen Pager displays your report.

Use the Screen Pager menu to view your report. 
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Next, Prev: These options cause your report to scroll one page, either forward 
(Next) or backward (Prev).

Right, Left: These options cause your report to scroll 15 columns horizon-
tally.

Top, Bottom: These options jump to the top or bottom of your report.

Scroll, Up-scroll: These options move your report one line down (Scroll) or 
up (Up-scroll).

Quit: This option exits the Screen Pager.

14. After viewing your report, select Quit.

 This brings you back to the Choose a Destination list. 

15. From the Choose a Destination list, select the Quit option. 

This brings you back to the Report Writer’s main menu. The File pull-down 
menu is open. 

16. Select the Exit the Program option.

A prompt appears and asks if you are ready to quit.

17. Select YES.

Report Writer exits and you are returned to the UNIX prompt.

This concludes the steps for building a simple report. The following sections dis-
cuss Report Writer’s menu options and features in more depth. The final section 
takes you through the steps for creating a more complex report using relationships 
and multiple tables.
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Using the Report 
Writer

This section covers the following topics:

n Choosing a Data Group

n Selecting the Main Table

n Choosing the Report Format

n Describing the Report

n Choosing Columns

n Arranging Columns

n Totalling Columns

n Specifying the Column Sort Order

n Grouping Columns

n Defining Selection Sets
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Choosing a Data Group

A data group is a set of database tables that contain related data. Choosing a data 
group limits you to a specific group of information, so you need not wade through 
your entire database to find specific information for a report. Data groups allow you 
to build reports quickly, utilizing only the information you need.

To choose a data group:

1. Select the New Report option from the File pull-down menu.

The Choose a Data Group list appears.

2. Choose the data group you want.

For information on defining new data groups refer to "Defining Data Groups" on 
page 7-5.



Fitrix Report Writer User Reference

Selecting the Main Table 4-3

Selecting the Main Table

After you select a data group, the Choose a Table list appears.

The tables that appear in this list are components of the data group you chose. From 
this list you select the main table for your report. The main table determines the col-
umns your report references. The main table is the base of an extended data struc-
ture. This structure is defined by the relationships between the tables in your 
database. The main table also determines which selection sets you can use with 
your report. For more on selection sets, see "Defining Selection Sets" on page 4-18.

The Table Help Form

Every table in your database can contain two names: a familiar name and a techni-
cal name. Sometimes the technical name for a table is very cryptic and hard to 
remember. By assigning a familiar name to your tables, you make your database 
easier to use. You can see both names for a table from the Choose a Table list. 

To see both names for a table:

1. Highlight the table for which you want to see both names.

2. Press [CTRL]-[w].
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The Table Help form appears.

3. Select the Quit option to return to the Choose a Table list.
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Choosing the Report Format

A report format describes the page layout for your report. You can define new 
report formats with the Formats option under the Options pull-down menu. 

If you have any report formats defined, the Choose a Format list appears after you 
select your main table. 

Note

If you have not defined any report formats, the Report Description form appears.

The Choose a Format list displays all the defined report formats. If you do not 
choose a format from this list, a default format is used. For more information on 
report formats, refer to "Updating Report Formats" on page 6-14.
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Describing the Report

Once you select a format for your report, the Report Description form appears.

You can also open the Report Description form with the Main Description option 
under the Report pull-down menu.

The Report Description form displays the main characteristics of your report, such 
as the data group, table name, and report format. Although some of the information 
on this form appears by default from your previous selections, you can still change 
them. You cannot change the Database, Author, Date Changed, or Data Created 
fields.

Report Name: This field holds the name of your report.

Data Group: This field contains the name of the data group your report refer-
ences. From this field you can change or add data groups to your report.

Although you are not required to specify a data group, it is strongly recommended. 
Some tables in your database are joined to many other tables, which may contain 
information non-relevant to your report. By specifying a data group, you limit the 
scope of data your report uses, which in turn saves you time.
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Pressing [CTRL]-[z] while the cursor is in the Data Group field displays a Zoom 
containing a list of data groups. You can select a data group by highlighting it and 
pressing [ENTER]. For more information, refer to "Defining Data Groups" on page 
7-5.

Table Name: This field contains the familiar table name of the table you chose for 
your report. Press [CTRL]-[z] to see a list of other available tables.

Table: This field contains the technical table name of the table you chose for your 
report. This field is synonymous with the Table Name field. Its purpose is to pro-
vide an alternate means of selecting the main table for the report. You can select a 
table by its technical name or by its familiar name. A Zoom is available to select a 
table.

Selection Set: This field contains the name of the default selection set for your 
report. A selection set contains selection criteria for a set of data. For example, you 
may wish to list your inventory by expensive items and inexpensive items. You 
could build a selection set showing items in your inventory that cost over $200. 
Likewise you could build a selection set listing items equal to or less than $200. For 
more information see "Defining Selection Sets" on page 4-18.

Report Format: This field lets you specify the format for your report. You can set 
up report formats with the Formats option on the Options pull-down menu. 

The middle portion of the form contains size and margin field measurements. A 
standard 8 1/2 x 11 sheet of paper is 80 columns (or characters) wide and 66 rows 
long. Report Writer can create reports with any page length and widths between 2 
and 256 columns. Report margins are measured in the same units as length and 
width (columns and rows). 

The bottom third of the form contains the login name of the author, modification 
and creation dates for the report, and a security feature. 

Private Report: This field determines who can use the report. If you do not want 
anyone else to use it, type Y in the Private Report field. 

Defining Report Level Help

You can create online descriptions for your reports so you, or anyone else who uses 
your reports, can quickly identify what the report covers. 
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To create an online description for a report:

1. From the Report Description form, press [CTRL]-[n].

The Report Help form appears.

2. Type in a description of your report.

If your description is several lines long, you need to press [ENTER] at the end 
of each line to wrap your text.

3. When you are done entering text, press [ESC] to store your description.

To view an online description of a report:

1. Select the Load a Report option from the File pull-down menu.

The Choose a Report list appears.

2. Highlight the Report for which you want to see a description.

3. Press [CTRL]-[w].

The Report Help form appears and displays your online description.

4. Select the Quit option to exit the Report Help form.

When you take the time to create online descriptions for your reports, you store 
valuable information about each report, which anyone can view. This level of con-
text-sensitive help prevents your system from becoming cryptic and difficult to use. 
As you build more and more reports, take a moment to create brief descriptions for 
each one.
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Choosing Columns

Once you fill in the Report Description form and press [ESC] to save the informa-
tion, the Choose the Columns list appears.

The Choose the Columns list lets you select which columns you want to appear in 
your report. The table you chose for your report determines which columns appear 
on this list.

To select a column for your report:

1. Use the arrow keys to highlight the column.

2. Press [ENTER].

An asterisk (*) appears preceding the column name.

3. Move to any additional columns you want to use and press [ENTER].

4. When you are done selecting columns, press [ESC] to store your choices.

To unselect a column:

1. Use the arrow keys to highlight the column.

2. Press [ENTER].

The asterisk preceding the column name disappears.

You can add columns to your report from different tables, which are directly or 
indirectly related to your report’s main table.
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To add columns from a different table:

1. From the Choose the Columns list, press [CTRL]-[z].

A Zoom appears listing tables (or Data Files) that are related to your main table.

2. Select the table from which you want additional columns.

A list of the columns in that table appears.

3. Select the columns you want to use.

4. Press [ESC] to return to the Choose the Columns list.

Note

Two tables can contain columns that share the same name. Be sure to select the 
columns that contain the data you want. For example, if you want an inventory 
code for each order line item on a report that prints customer orders, be sure to 
select the Inventory Item Code from the Order Line Items table. The Inventory 
Item Code column name may appear in many tables. Although a column can be 
named the same in several tables, like-named columns can produce very differ-
ent results, depending on the table to which they belong.
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Arranging Columns

Once you select the columns you want to use, the Arrange Columns form appears. 

Initially, the columns appear in the order you selected them from the Choose the 
Columns list. The sequence number beside each column name determines the order 
the columns are displayed on your report. If all your columns can be displayed on a 
single row, the sequence number orders your columns to appear from left to right. If 
your columns cannot fit on a single row, the sequence number orders them to 
appear from top to bottom.

On the Arrange Columns form, you can change the order of your columns in two 
ways: 

1. In the Sequence field, type the number that corresponds to where you want the 
column to appear on your report. 

2. In the Column field, type the name of the column that corresponds to the appro-
priate sequence number. 

You can also move columns around on your report manually with the Report Edi-
tor. The Report Editor is discussed in "Editing the Report Layout" on page 6-4.

Totalling Columns

In the Total? field, you can specify which columns Report Writer totals at the end 
of your report. If you want a column totalled on your report, type a Y in the Total? 
field. If you don’t want a column totalled, leave the Total? field blank or type an N 
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in the field. Only numeric columns can be totalled. You can also subtotal columns, 
but for subtotals you must first define a group by which to sort your data. For more 
on subtotals, see "Group Subtotalling" on page 4-15.



Fitrix Report Writer User Reference

Specifying the Column Sort Order 4-13

Specifying the Column Sort Order

Report Writer lets you specify how your columns are sorted. For example, you can 
sort your columns alphabetically by your customer’s last name. Or you can orga-
nize your data into groups and sort the groups. For example, you can group your 
data by the City column and sort the City names alphabetically. The possibilities 
are endless because you can specify as many as eight groups. Groups also let you 
subtotal columns. This section provides an overview of the Group and Sort option 
under the Report pull-down menu and the Sort form. For more on grouping, see 
"Grouping Columns" on page 4-15. 

To specify the column sort order:

1. Select the Group and Sort option under the Report pull-down menu.

The Choose the Sorting Columns list appears.

2. Select the columns by which you want to sort your data.

3. Press [ESC].
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The Group and Sort form appears with the columns you selected.

Use the [ENTER] key to move the highlight between the fields on the Sort 
form. The following list describes each field:

Seq: This field determines column sort precedence.

Sort?: This field determines ascending or descending sort order.

Group?: This field determines if your report groups by this column. For more 
on grouping, see "Grouping Columns" on page 4-15.

Page Bk.: This field determines where page breaks occur. See "Before Group 
and After Group Page Breaks" on page 4-17.

Column: This field identifies the column by which to sort and group.

4. Press [ESC] to store the sorting information.

Column Types Ascending Descending

Character A-z z-A 

Numeric 1-100 100-1 

Date Past-Current Current-Past 
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Grouping Columns

The Group and Sort option under the Report pull-down menu lets you specify the 
columns by which you group your data. For example, perhaps you want to group 
your customers by location. You first group your customers by the State column, 
then by the City column. In a report created this way, all your California customers 
are listed together in one group. Inside the California group is a Sacramento cus-
tomer group, a San Francisco customer group, an LA customer group, and so on. 
The only limitation is how many customers you have.

Groups make reports easy to read and understand. Groups also let you add subtotals 
to your reports. A report can contain up to eight groups. 

To select a column by which to group your data:

1. Open the Group and Sort form.

To open the Group and Sort form, follow the steps in "Specifying the Column 
Sort Order" on page 4-13.

2. Place a Y in the Total? field of the column you want to group.

3. Press [ESC] to store the grouping information.

In the Report Editor, your report now appears with B1 tags (see next page) just 
below the HD tags. On the row of the new B1 tag is the column you chose. For 
more on block tags, see "Report Blocks" on page 6-6.

Group Subtotalling

When you create groups for your data, any columns you chose to total in the 
Arrange Columns form become subtotalled by group. For example, if you grouped 
your data by the State column, for each State in your report, your data is subto-
talled. At the end of your report is a grand total. See "Totalling Columns" on page 
4-11 for more information on the Arrange Columns form.

You may define up to eight groupings for a report on which subtotals are kept for 
up to 20 columns. The Report Writer automatically formats your report, breaking 
out the group columns from the report body columns. However, you can manually 
format your report with the Report Editor (see "Editing the Report Layout" on page 
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6-4). The group columns are displayed in a Before block and the subtotal columns 
are displayed in an After block. Grand totals for all subtotalled columns are printed 
at the bottom of the report in the Last Row block.

Tag Block

HD Page Header 

FR Header for First Page 

B1... Before (1-8) 

Blank Report Body 

A1... After (1-8) 

LR Last Row 

TR Page Trailer 
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Before Group and After Group 
Page Breaks

The Report Writer allows you to place page breaks before or after groups. From the 
Report pull-down menu, select Group and Sort. You are asked for the columns you 
wish to sort by. After selecting the columns, press [ESC] to store your choices. 
Now the Group and Sort form appears. This form allows you to specify the sorting 
sequence, ascending or descending sort order, grouping, and page break. For more 
on sort order and grouping, see "Grouping Columns" on page 4-15.

There are three options to specify for Page Break (Page Bk.). They are Before, 
After, or None. Choosing None prints the report with the default page breaking 
(every 66 lines or whatever the page length is set for in the Report Description 
form). 

The Before option is specified by placing a B in the Page Bk. column.

The After option is specified by placing an A in the Page Bk. column.
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Defining Selection Sets 

A selection set is a group of columns and their selection criteria. When chosen at 
run time, selection sets determine the data that is displayed on the report. Selection 
sets are not tied directly to any given report. Instead they are tied to a data set which 
is determined by the main table. The data set is expanded by table relationships 
stored in the database to include all columns from all related tables no matter how 
indirectly related they are. Thus all reports based on a given main table can use any 
selection set also based on the same table.

In essence, the report and its selection set are two completely independent ele-
ments. All reports that share a common data set (the same main table) can use any 
selection set defined for that data set. The report and the selection set are merged at 
run time to build the required SQL query for the data you desire.

This mechanism of building and preparing the SQL query at run time allows for an 
extremely flexible and powerful environment. For example, you may have three 
reports which use the customer table as their main table. If you define multiple 
selection sets for the customer table, you can apply any saved selection set to any of 
the three reports.

Another example is if you have 10 reports based on the same main table and you 
have 10 selection sets based on that same table, you actually have 100 different 
reports that can be printed at any time.

When you print a report, you are prompted to choose a selection set. If a default 
selection set has been specified on the Report Description form, you are asked 
whether you want to use the default selection set. If you want to use the default 
selection set, answer YES to the prompt. If you want to use a different selection set, 
answer NO to the prompt for the default set. If you choose NO, the Selection Set 
list appears, allowing you to choose another selection set. You may also choose not 
to use a selection set at all, by specifying CANCEL.

Printing a report causes the Report Runner to build the SQL query. This query cor-
rectly joins the tables required both for the report and selection set, along with any 
special sorting order determined by the report, selection set, and the data selection 
criteria from the selection set.

Report Writer allows you to define any number of data selection sets. You can save 
or modify any selection set you create. If you reload and rework a selection set, you 
may overwrite the old selection set, or save the reworked version independently.
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You can build selection sets with the Selection Sets option on the Report pull-down 
menu. The Selection Sets option displays the Selection Set list. This list contains all 
of the selection sets available to your current report. After you choose a selection 
set, the Sorting and Data Selection Columns form appears. This form allows you to 
define the sort order precedence, type of sort, and the selection criteria for the col-
umns in your selection set. 

Sequence: This field determines column sort precedence.

Sort: This field determines whether the column is sorted in ascending or descend-
ing order if you want an order. 

Selection Data: This field stores the criteria for creating the SQL query. 

Column: This field stores the column name. 

Don’t confuse this form with the Group and Sort form. The Sorting and Data Col-
umns form specifies a selection set. Selection sets tell Report Writer how much 
data to use. The Group and Sort form specifies column groupings. Column group-
ings tell Report Writer how the data is organized on the report. 

Building Selection Criteria

The Selection Data field on the Sorting and Data Selection Columns form allows 
you to build simple or complex selection clauses to limit the selection of data. If 
you are not familiar with SQL selection statements, Report Writer makes it easy to 
construct one using Zooms. 
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Building Selection Criteria Using Zooms

The Selection Data field contains a Zoom to aid in building your selection clause. 
Pressing [CTRL]-[z] in the Selection Data field displays the name of the column as 
well as a list of possible comparison operators. The list of operators reflects the 
type of column you are using. It differs between character, numeric, and date col-
umns.

From this list you can pick a clause to use with your selection criteria to determine 
the data that appears in your column. When building your selection criteria, think 
about the following sentence when choosing a clause: "select the data that..."

After you choose an operator, you are prompted for the specific type of criteria that 
is needed for that operator.

For example, after you select the Begins With clause, a prompt appears allowing 
you to enter your selection pattern. In this prompt you enter the text for your select 
statement. If you specify an S, the column displays all data that begins with an S.

Note

The comparison operators are case sensitive (i.e. they differentiate between 
uppercase and lowercase), so be aware that if what you specify begins with s, 
and there is no data that begins with a lower case s, no data gets selected.

Character Numeric Date



Fitrix Report Writer User Reference

Defining Selection Sets 4-21

Pressing [ENTER] after specifying criteria displays the Boolean Operators list.

This list allows you to add boolean expressions to your selection clause. These 
expressions enable you either to make your selection statement more restrictive or 
to add an alternate matching statement.

If you select And or Or then the Comparison Operators list reappears, enabling you 
to continue building your clause.

When you finish building your clause, select Done from the Boolean Operators list. 
Your clause is transformed into the SQL selection statement, which appears in the 
Selection Data column.

The Selection Data field does not necessarily display the Comparison Operators as 
you selected them. Rather, the Report Writer expands the operators into their actual 
SQL syntax. For example, if you choose the Begins With operator and specify an s 
on the next prompt, the SQL statement resembles the following line:

@ matches ’s*’ 

The at (@) sign stands for the table.column part of the SQL statement.

The following tables display comparison operators and their SQL query equiva-
lents. 

Clause SQL Equivalent

Matches @ matches ’text’ 

Equals @=column_name 

Is in List @ in (’text1’,’text2’,’text3’) 

Between @ between ’text’ and ’text’ 

Contains @ matches ’*text*’ 



Fitrix Report Writer User Reference

4-22 Using the Report Writer

 

Ends With @ matches ’*text’ 

Doesn’t Equal @ != column_name 

Doesn’t Match @ not matches ’text’ 

Is Not in List @ not in (’text1’,’text2’,’text3’) 

Clause SQL Equivalent

Equals @ = ’number’ 

Between @ between ’number’ and ’number’ 

Greater Than @ > ’number’ 

Less Than @ < ’number’ 

Greater or Equal @ >= ’number’ 

Less or Equal @ <= ’number’ 

Is in List @ in (’number’,’number’,’number’) 

Doesn’t Equal @ != ’number’ 

Is Not in List @ not in (’number’,’number’,’number’) 

Clause SQL Equivalent

Equals @ = ’date’ 

After @ > ’date’ 

Before @ < ’date’ 

Between @ between ’date’ and ’date’ 

Is in List @ in (’date’,’date’,’date’) 

Clause SQL Equivalent
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Building Selection Criteria Manually

If you are familiar with SQL select statements you can build manually your SQL 
selection clause by typing it directly into the Selection Data field. The Selection 
Data field can store an SQL statement up to 100 characters long. 

If you need more than 100 characters, you can continue the SQL statement on the 
following row of the Data Selection form. Continuous Selection Data fields are 
linked by an And statement. 

For example, if you run out of room while building your SQL statement, you can 
move down to the next row of the Data Selection form and continue building the 
SQL statement in the Selection Data field. Be sure to enter the name of the field on 
this next row. When manually building your SQL statements, use @ to abbreviate 
the current table.column name.

Creating Selection Set Online Help

You can create online help for selection sets by displaying the Selection Set Defini-
tion form, pressing [CTRL]-[n], and entering text into the notes form. Text entered 
into the notes form becomes the online help for the selection set. After help is 
defined for a selection set, you may display it by pressing [CTRL]-[w] when the 

Doesn’t Equal @ != ’date’ 

Not Between @ not between ’date’ and ’date’ 

Is Not in List @ not in (’date’,’date’,’date’) 

Key Action

[CTRL]-[a] Insert space

[CTRL]-[x] Delete character

[CTRL]-[d] Delete to end of line

[CTRL]-[u] Undo an edit

Clause SQL Equivalent
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selection set name appears. Defining help is an important step in maintaining the 
usefulness of your growing collection of reports and selection criteria. Creating 
help lets you and other users keep track of multiple selection sets.
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5
File Pull-Down 
Menu Options

This section covers the following topics:

n New Report 

n Load a Report

n Print Report

n Save the Report

n Import/Export

n Exit the Program
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New Report

Creating a new report is easy with the Report Writer. The New Report option under 
the File pull-down menu initiates a sequence of prompts that lead you through the 
report building process. These prompts guide you step-by-step, requiring you to 
enter basic report information. Help and Zooms are available throughout the report 
building process. 
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Load a Report

The Load a Report option under the File pull-down menu lets you view, print, or 
modify an existing report. 

After you select Load a Report, the Choose a Report Group list appears. This list 
contains all the predefined report groups and an All Reports option. The All 
Reports option leads to a list of the reports not in a Report Group. For more on 
Report Groups, see "Grouping Reports" on page 6-16.

After you select a Report Group or the All Reports option, the Choose a Report list 
appears.

The following options appear on the Choose a Report list: 

Current Report: This option reloads the current report. 

Last Report: This option loads the last report printed (the report appears un-
named). 

Report-Name: This option loads the report. 

The Last Report and Current Report options appear only if applicable.
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Print Report

Report Writer lets you print your report with the Print Report option. You must 
save your report before you print it. If you have not saved your report before select-
ing the Print Report option, a prompt appears so you can save it. After saving your 
report, you see either the Use the Selection Set default prompt or the Choose a 
Selection Set list.

If you select the Print Report option when a report is not loaded, a list of reports 
appears, allowing you to select the report you want to print.

Choosing a Selection Set

After you choose the Print Report option, if you have specified a default selection 
set on your Report Description form, you are asked if you want this selection set for 
the printed report. If you want to use the default selection set, select YES. If you 
want to use a different selection set select NO. A list of available selection sets 
(selection sets based on the same main table) appears, allowing you to specify the 
selection set you want to use.

If you did not specify a default selection set on the Report Description form, the 
Choose a Selection Set list appears, displaying the available selection sets. 

If you select CANCEL or press [DEL], when first offered a selection set, the Report 
Runner goes right to the Choose a Destination list, without prompting you for a 
selection set. For information on selection sets, refer to "Defining Selection Sets" 
on page 4-19.

Choosing the Destination

After you choose a selection set, the Choose a Destination list appears.

You can choose a number of destinations for your reports, including screen, file, 
printer, mail, archive, or fax. Choose the Display to Screen option to display your 
report to the screen. See "Displaying Reports to the Screen" on page 5-6 for more 
information.
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Output to Printer: This option displays a list of printers. Printers are defined with 
the Update Printers option under the Options pull-down menu. To print the report, 
select the printer you want.

Write to File: This option lets you save the output of your report to a file. If the 
file name you specify exists then you are prompted to append the file. Yes appends, 
No overwrites, Cancel brings you back to the Choose a Destination list.

Archive to Database: You can store the output of your report in a table in the 
database by selecting this option. The text of the report is stored in two tables, 
cgrarchr and cgrarchd. The first stores basic information such as the report 
name, user, date, time, selection set, and primary query. The second, stores the 
actual data the report gathers.

Export Data: This option prints the report detail in an ASCII delimited format so 
programs like Lotus 123 can use it. After selecting Export Data, select the Delim-
ited File option from the Choose a File Format list. The report detail is then saved 
in ASCII format with data in quotes and comma delimiters.

Reporting Options: This option displays the Select an Option list. This list lets 
you control the level of detail to which your report is printed. The Select an Option 
list includes the following options:

Summary Only: This option causes only the before and after field columns to 
print on your report. This means that only group by and subtotal columns will 
print on the report. All body (detail) columns will be suppressed.

Test Length: This option prompts for the number of rows to print. This 
option allows you to print a limited number of rows so you can see whether the 
report is printing as it should. This feature allows you to check long reports 
without actually printing out the entire report.

Form Alignment: This option lets you align forms in the printer without actu-
ally printing out the report. Positioning marks are sent to the printer (with no 
data, just empty field marks), then you are asked whether the form is aligned or 
not. Answering no to this prompt loops you back to check the test print out. The 
Report Runner continues to send the test print until you answer Yes to the 
prompt.

Data Selection: This option displays the Choose a Selection Set list so you 
can select which selection sets to use with your report. After specifying the 
selection sets, you return to the Choose a Destination list.
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Create Data Table: Prompts you for the name of a table, which will be cre-
ated to store the report data. Subsequent reports can then be run on that table 
against the data you selected in a previous report. By limiting the data that sub-
sequent reports can run against, the report runs faster.

The Mail and Fax options only appear on the Choose a Destination list when their 
environment variables are set up. 

Mail: This option sends your report as a mail message. The $rpt_mailcmd vari-
able must be set to a mail program that accepts the text of the mail message as 
input. The following must be the last argument on the command line: 

’-s "subject" user.’ 

Fax: This option sends your report over a fax modem. You must have fax software 
set up on your system. If you have not set up your fax machine, when you select 
this option, a brief message appears suggesting that you call our organization for 
more information or obtain a compatible fax modem.

You must set the $faxnum variable to specify the program to run when you are 
sending a fax to a specific phone number. The standard input to the program is the 
text of the fax, and argument #1 to the program is the phone number to dial. For 
example:

faxnum="fx -n" 

This variable is required to run fax as a destination.

Displaying Reports to the Screen

Report Writer lets you display reports, even larger than 80 columns, to the screen 
with the Report Pager, which starts when you select Display to Screen from the 
Choose a Destination list. The Report Pager uses several options that let you view 
the entire report.

Next, Prev: These options scroll your report one page, either forward (Next) or 
backward (Prev).
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Right, Left: These options scroll your report horizontally 15 columns.

Top, Bottom: These options jump to the top or bottom of your report.

Scroll, Up-scroll: These options move your report one line down (Scroll) or up 
(Up-scroll).

Quit: This option exits the Report Pager and returns you to the Choose a Destina-
tion list.

Printing Reports from the Command Line

You can print reports from the command line without running Report Writer. The 
Report Runner is a utility that runs reports without loading the Report Writer. The 
following is the syntax for the Report Runner:

fg.runner -dbname database -r "report-name"
[-s "selection-set"] 

In order to print reports outside of Report Writer you must know the name of the 
report, database, and selection set to use if any. If a name contains spaces, you must 
place it in quotes. For example:

fg.runner -dbname sales -r "Weekly Sales" -s 
"US Division" 
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Save the Report

When you work on a report, a temporary work space is opened in your report data-
base. This temporary work space is overwritten each time you load a report. In 
order to retain your work you must save your reports with the Save the Report 
option under the Report pull-down menu. Running this option saves a copy of your 
report to the database, where you can retrieve it later. When saving, you are 
prompted with the name of the report and allowed to overwrite it with a new name.
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Import/Export

Using the Import/Export feature of the Report Writer lets you move reports defined 
in one database to another database. The option prompts you to Import or Export. 

In order to move a report to another database (which may be on another system), 
you must convert the database definition of the report into an ASCII file format 
using the Import/Export option on the File pull-down menu. If you select Export, 
you are prompted for the name of a file in which to save the ASCII definition of the 
report. Give this file a .ifg extension.

The .ifg extension indicates a report specification file and contains the information 
necessary to move a report from one system to another. 

After exporting a report, the next step involved with moving a report to a different 
database involves Importing the exported report’s .ifg file. If you are moving 
reports between systems, you must move the exported .ifg file to the target 
machine, run Report Writer and then Import the report.

Note

It is necessary to have table/column definitions that are the same as the defini-
tions that existed in the database from which you exported the report. The 
Report Writer notifies you if the report requests data from tables/columns that 
don’t exist in the new database. 
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Exit the Program

You can quit Report Writer by choosing the Exit the Program option under the File 
pull-down menu. This option prompts you to save any unsaved report, then exits.
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6
Other Report Writer 
Features

This section covers the following topics:

n Building the Report Layout

n Editing the Report Layout

n Using the Column Detail Zoom

n Updating Report Formats

n Adding Printers

n Grouping Reports

n Using the Delete Options

n Using Online Help 
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Building the Report Layout

When you save any changes made to the Arrange Columns form, the Report Writer 
automatically formats the selected columns on the report. You can manually edit 
the placement of columns with the Edit the Report option under the Report pull-
down menu.

Note

If you have run the Edit the Report option and have made any manual changes to 
the report, a prompt appears informing you that any manual changes you may 
have made will be lost if you save your changes on the Arrange Columns form. 
In other words, if you manually edit a report, you should not run the Arrange 
Columns option, or remake the report unless you want the report to be reformat-
ted.

The automatic column formatter displays columns across the top of the report from 
left to right when the column names and column fields can fit within the width 
defined for the report. Report data appears beneath the column name.

If you try to insert more columns than can fit on a single row, the automatic column 
formatter left-justifies all of the column names placing the column fields to the 
right of their name. 



Fitrix Report Writer User Reference

Building the Report Layout 6-3

Note

If you find that the automatic column formatter left justifies your columns and 
you want them to appear across the top of the page, either increase the column 
width of your report, or, if a particular column is unusually large, give it a 
shorter name. See "Naming Columns and Tables" on page 7-2.

You can modify the width of the report at any time by selecting the Main Descrip-
tion option under the Report pull-down menu.

The automatic column formatter also formats column groups and subtotals. If you 
specify a column to group by, the automatic formatter places that column before the 
body columns.
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Editing the Report Layout

The Report Writer enables you to manually edit the column layout created by the 
automatic column formatter. Selecting the Edit the Report option under the Report 
pull-down menu puts you in the Report Editor, which contains an image of your 
report. The Report Editor is a WYSIWYG (What You See Is What You Get) editor 
in which you can add, delete, or rearrange columns, groups, and text. You can then 
see the result of your changes on the screen. To view the entire report, you can 
scroll up, down, left, and right with the arrow keys. 

Rulers make up the top and left edges of the Report Editor, indicating the column 
and line numbers. A header row containing the page number, report title, and date 
is automatically created by the Report Writer. 

When the cursor is in the Report Editor, you can use a number of Informix-defined 
editing keys. The Report Writer uses additional keys that let you edit rapidly, eas-
ily, and efficiently.

Key Stroke Action

[CTRL]-[a] Insert space

[CTRL]-[x] Delete space
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In the Report Editor, you can undo (with [CTRL]-[u]) a series of editing actions, 
but you cannot undo an undo. For example, if you delete two lines without doing 
anything else in between (like moving), undo restores both lines. If you type a 
string of characters, undo erases the whole string. If you delete a series of charac-
ters, undo restores all of them. Undo restores the last editing action in the last series 
of editing events. Creating new columns and groups can also be undone, but creat-
ing consecutive new columns or new groups is not considered a series of events, so 
only the last one is undone.

Note

You must use Informix termcap definitions. If you find that the keys shown in 
the previous table do not operate as expected, the problem is likely in the term-
cap definition used for your particular terminal. For information regarding the 
specification of termcap definitions, please see your Informix documentation, or 
talk to your system administrator.

[CTRL]-[d] Delete to end of line

[CTRL]-[p] Paste a line

[CTRL]-[u] Undo an edit

[F1] Insert a blank line

[F2] Delete a line

[ Define a new column

{ Define a new block

[ESC] Save

[DEL] Cancel

Key Stroke Action



Fitrix Report Writer User Reference

6-6 Other Report Writer Features

Cut and Paste a Line

The Report Editor lets you cut and paste entire lines. 

To cut and paste a line:

1. Place the cursor on the line you wish to cut.

2. Press [F2]. 

The line disappears.

3. Move the cursor to where you wish to paste.

4. Press [CTRL]-[p].

Report Blocks

The Report Editor places identifier tags on the left edge of the report image, indi-
cating what report blocks the columns belong to. 

The HD tag indicates the Header blocks of the report. The Header blocks contain 
information that appears on every page of the report. Usually information such as 
page numbers and report titles are contained in the Header blocks. 

Block
Tags



Fitrix Report Writer User Reference

Editing the Report Layout 6-7

The FR tag indicates the Header for First Page block. It replaces the HD Header 
blocks on the first page of your report, so you can customize the way your first page 
appears. For example, you may not want a page number on the first page of your 
report. 

The B1 tag indicates the first Before block. There can be as many as eight Before 
blocks. Subsequent Before blocks are numbered B2, B3, B4, and so on. The B1 tag 
is called a Before block because it is before the Blank tag, which supplies the body 
portion of the report. Before blocks contain information such as column titles. 

The Blank tag represents the report body. It is where information from the database 
appears on your report. 

In the figure on the previous page, the Blank tag holds various customer informa-
tion, such as customer number, first name, and last name. 

The A1 tag appears after the Blank tag and is therefore called the After block. After 
blocks contain subtotal information. After blocks correspond with Before blocks. 
For example, A1 After blocks hold subtotal information for B1 Before blocks, A2 
for B2, and so on.

The LR tag indicates Last Row blocks. Last Row blocks are a logical place for 
grand totals, which appear only once in the report.

The TR tag indicates Page Trailer blocks. Page Trailer blocks are a good place to 
include information such as footers, or you can put page numbers here instead of in 
the Header blocks if you want.

Tag Block

HD Page Header

FR Header for First Page 

B1... Before (1-8)

Blank Report Body

A1... After (1-8)

LR Last Row

TR Page Trailer
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Adding Report Blocks

You can add a new block to your report from the Report Editor by pressing the left 
brace key ({). If you want to add a Before block (B1), you must first define the 
grouping column in the Sort the Report form (see "Grouping Columns" on page 4-
16). 

To add a new block:

1. Position the cursor a line above where you want the block to appear. 

You can only start certain blocks in certain places. For example, you cannot 
start a page trailer block in the middle of a before block. You would need to 
position the cursor on the last row of the last after block in order to add a page 
trailer block. 

2. Press the { key.

The Report Editor determines where the cursor is in regard to other blocks, and 
responds with a prompt indicating which blocks, if any, you can add at the cur-
rent cursor location. If no blocks can be added at the current cursor location, a 
prompt says that you must move to another location. The ability to manually 
add report blocks via the Report Editor lets you modify default formats or 
replace blocks that may have been accidentally deleted when you were custom-
izing the report.

Adding Columns

The Report Editor lets you add new columns or other special report values, such as 
a page number and the report’s title.

To add a column or special value:

1. Move to where you want the new column or value to appear.

2. Press the [ key.
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Note

You must be in a group in order to call up the new column menu. If you are not 
in a group, you must start a new group with the left brace ({) key.

The Choose a Column Type list appears.

3. Select the column type or special value you want to insert.

Database Column: This option displays a list of columns related to the main 
table. You may select which column you want to place on the report by pressing 
[ENTER]. If the column you want to add is not related to the main table, you can 
press [CTRL]-[z] to display a list of related tables. You can then select the table 
that contains the column you want by pressing [ENTER]. A list of the related 
table’s columns appears. Choose the column you want by pressing [ENTER]. After 
you select the column, the column list closes, and the column is automatically 
placed in the report.

Note

A column label is not automatically displayed when you select columns from 
within the Report Editor. You must type the label for the column you want to 
appear on the report.

Subtotaled Value: This option displays a list of columns which you may subto-
tal. The columns displayed on this list are the numeric columns already defined for 
this report. Choose the column you want to subtotal. The subtotal column appears 
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where you pressed the left square bracket ([). It is also possible to hide this field if 
you want to perform calculations that you don’t want to appear on the report. See 
"Using the Column Detail Zoom" on page 6-12 for more on hiding columns.

Grand Total Value: This option displays a list of columns which may be subto-
taled. You determine which subtotaled columns to total and the location for the 
grand total column. The columns displayed on this list are the numeric columns 
already defined for this report. After you choose the column to be totaled, the grand 
total column automatically appears where the left square bracket ([) was pressed. It 
is also possible to hide this field if you want to perform calculations that you don’t 
want to appear on the report. See "Using the Column Detail Zoom" on page 6-12 
for more on hiding columns.

Math Formula: This option allows you to create math columns. You can build a 
math formula using any numeric column defined for the report or a constant value. 
Selecting this option displays a prompt. At this prompt you can enter either a con-
stant value, or the name of a numeric column selected for this report. Zoom is avail-
able to help you select a valid column. After filling in this prompt, a menu is 
displayed containing math operators. Select the operators you want. Another 
prompt will appear allowing you to enter a constant or another numeric column. 
The size and format of this column is determined by the first column if the two col-
umns are used in the math operation. If a constant is used with a column, the com-
puted column uses the format and size of the column. It is also possible to hide this 
field if you want to perform calculations that you don’t want to appear on the 
report. See "Using the Column Detail Zoom" on page 6-12 for more on hiding col-
umns.

Constant Value: Use this option to create a column with a constant numerical 
value. It is also possible to hide this field if you want to perform calculations that 
you don’t want to appear on the report. See "Using the Column Detail Zoom" on 
page 6-12 for more on hiding columns. 

Runtime Report Value: This option displays a menu of special report values that 
allow you to place special report characteristics on your reports. These special val-
ues are:

Page Number: This value allows you to print the page numbers on your 
reports. 

Time of Printing: This allows you to place a time stamp on your reports. For 
example, the time stamp may look like "09:11." 
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Date of Printing: This allows you to place a date stamp on your reports. The 
date appears in the format mm/dd/yyyy. For example, 09/05/1991. 

Report Title: This allows you to print a title on the report. 

Selection Set Name: This allows you to print the name of the selection set 
used to print the report. 

Report User Name: This allows you to print the name of the person who ran 
the report. 

Row Count: This option will display the total amount of rows in the report.

Row Number: This option will display the number of the current row.

The Report Writer automatically provides the correct number of spaces for the 
column or special value.

Hidden Columns: This option searches for any hidden fields that may be in the 
report. Hidden fields are fields that are used for holding data that you do not want to 
have appear on the report. One use for hidden fields is to perform calculations that 
will be used in other calculations. 



Fitrix Report Writer User Reference

6-12 Other Report Writer Features

Using the Column Detail Zoom

You can access the Column Detail Zoom when you are using the Report Editor. 
Place the cursor on a field and press [CTRL]-[z]. The Column Detail Zoom gives 
you information about the field you are on, including column name, format, and 
hidden status. You can also open the Column Detail Zoom with the Arrange Col-
umns option under the Report pull-down menu.

Column Name: This field contains the technical table and column names, as well 
as the familiar column name. In the example above, the familiar name is Customer 
Number. 

Format: This field specifies how the data in this column appears on the printed 
report.

Option Result

right Right justifies the data in the field.

left Left justifies the data in the field.

center Centers the data in the field.

pushleft Moves the field to the left of the report, plus one space. 
This is handy for formatting first and last names.

flushleft Moves the field flush left without a space.

pushright Moves the field to the right of the report, plus one space.
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You can also use Informix formatting strings such as & and #. However, the Report 
Writer does not accept the date formatting strings. The date formatting is handled 
through the use of the environment variable DBDATE.

Hidden?: This field determines whether the column prints or not. Type Y to hide 
the column on your report. Hidden columns are useful in math calculations, when 
you just want to show the result, not the entire calculation. 

You cannot change the other fields on this form from within the Column Detail 
Zoom.
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Updating Report Formats

You can create any number of report formats with the Report Writer. These formats 
determine the size of the report output.

When creating a report, you can choose an existing report format. You can custom-
ize a format for any particular report by adjusting report margin and size values on 
the Report Description form.

The Report Format form is displayed by selecting the Formats option under the 
Options pull-down menu. When you choose Add a Format, the Add a Format form 
appears. 

You can specify the format of the report output on this form. You can set up for-
mats for reports that print any width between 2 and 256 columns.

In the Report Format field, name the format you are defining. For instance, if you 
want to define a wide report format, one of 256 columns, call it Wide (256 col.) and 
type 256 in the Report Width field. You can also specify this format as the default 
format and the size of the report’s margins.

Use this feature to specify formats with names such as Wide, Default, Laser, Cor-
porate, or Local. This lets users choose formats that conform to existing layouts, 
without needing to know specific widths or margins.

Multiple report pages per output page is not available with this release.
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Adding Printers

The Printers option under the Options pull-down menu lets you define printer 
names and specify the operating commands necessary for initiating each printer. 
Most printers use the UNIX lp command, followed by a printer destination. For 
example:

lp -d dev 
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Grouping Reports

The Group Reports option under the Options pull-down menu lets you group 
reports into logical sets. 

To group reports:

1. Select the Group Reports option under the Options pull-down menu.

The Choose a Report Group list appears.

2. Select the Add a Report Group option.

The Define Report Groups form appears.

3. Name your report group and fill in the names of the reports you want to 
include in this group.

For instance, you might want to create a group named Invoicing, then include 
all the reports you’ve made that pertain to invoicing. This way, you don’t have 
to go through many other reports to get to the report you want.

4. Press [ESC] to store your report group.
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Using the Delete Options

The Delete pull-down menu has several options that let you easily delete certain 
items in your report writer database. The following list describes each delete 
option:

Old Reports: This option lets you delete a report from your database. When you 
select Old Reports a list of all your reports appears. Select the report you want to 
delete. Report Writer then prompts you to verify the deletion. 

Selection Sets: This option lets you delete a selection set. When you choose 
Selection Sets, a list of all your selection sets appears. Choose the selection set you 
want to delete. Report Writer then prompts you to verify the deletion.

Grouped Reports: This option lets you delete a report group. After you select 
Grouped Reports, a list of all your report groups appears. Select the report group 
you want to delete. Report Writer then prompts you to verify prior to deletion. 

Formats: This option lets you delete a report format. After you select Formats, a 
list of all your report formats appears. Select the format you want to delete. Report 
Writer then prompts you to verify prior to deletion. 

Printers: This option lets you delete a printer definition. When you select this 
option, a list of all your printer definitions appears. Select the definition you want to 
delete. Report Writer then prompts you to verify prior to deletion.

Data Groups: This option lets you delete a data group. A data group is a group of 
database tables. After you select Data Groups, a list of all your data groups appears. 
Select the data group you want to delete. Report Writer then prompts you to verify 
prior to deletion. Be aware that deleting a data group impacts all reports created 
with that group.

Relationships: This option lets you delete a table relationship. After you select 
Relationships, a list of all the table relationships appears. Choose the relationship 
you want to delete. Report Writer then prompts you to verify prior to deletion. 
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Using Online Help

Online help provides information about each aspect of the Report Writer, and can 
be accessed either from the Help pull-down menu or by pressing [CTRL]-[w] from 
any location. Context sensitive help is also available. To use context sensitive help, 
place the cursor on the area in question, and press the [CTRL]-[w] key sequence. If 
you need help about a menu option, select that menu option and press [CTRL]-
[w].

The Help pull-down menu lists several help topics. Choosing a topic displays a list 
of subtopics. Selecting a subtopic displays a Help form with information about that 
topic. You can view help text on the Help form by selecting the View option. Use 
the arrow keys to move through the help text.

The following list contains the Help form options:

Info: This option leads to the Program Information menu. The Program Informa-
tion menu contains options that provide additional functionality and program-level 
information. 

View: This option lets you move through the help text so you can view the text, if it 
cannot all fit in the Help form at once. Use the arrow, [F3], and [F4] keys to move 
through the text.

Update: This option lets you modify the help text. After you modify help text, 
press [ESC] to store your changes.

Quit: This option lets you exit the Help form and return to the previous list. 
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7
Defining Your 
Report Database

The Report Writer’s Options pull-down menu lets you or your database administra-
tor set up the Report database descriptions. You can attach more descriptive names 
to columns (so you don’t have to remember the technical names), define data 
groups (enabling you to group related tables), and define table relationships. 
Although Report Writer does not require you to set up database descriptions, it is 
strongly recommended. As you build more reports and add to your database 
descriptions, building reports becomes increasingly easy and fast.

This section covers the following topics:

n Naming Columns and Tables

n Defining Data Groups

n Defining Groups of Reports

n Defining Table Relationships

n Defining Column Joins 
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Naming Columns and Tables

Selecting the Table/Columns option from the Options pull-down menu displays a 
selection criteria prompt, which is used by several options in Report Writer. This 
prompt lets you enter selection criteria to find only those items that match the pat-
tern. All items can be selected by pressing [ENTER] at this prompt without typing 
anything else.

The Report Writer displays a list of all the tables in the database. You can choose a 
table by highlighting it and pressing [ENTER]. Pressing [CTRL]-[w] on a table 
name displays a Help form. The Help form contains the descriptive and technical 
table name as well as any information attached to the table.

After you choose a table, the Table Name form appears and lets you give the table a 
more descriptive name.

For example, you could name the customer table "Customer Information."
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After giving a descriptive name to the table, you can switch down to the Column 
Name form by pressing [TAB]. Attach a familiar name to each column in the table. 
After you enter a familiar name for a column, press [ENTER] to move the cursor to 
the Column Label field. The Column Label field lets you enter a label for the col-
umn when it appears on a report. 

The following is a list of the Table Name form’s fields:

Column: This field contains the database column name and cannot be edited. 

Column Name: This field contains the user-defined familiar name. 

Column Label: This field contains the user-defined label for this column when it 
appears on a report. 

Defining Help for Tables

You can define help text for any table. Press [CTRL]-[n] when the cursor is in the 
header section (the Name field) on the Table Name form. When you press [CTRL]-
[n] a Notes form for the selected table appears. You can enter any notes or help text 
about the selected table into this form. The text you enter on the Notes form 
becomes the on-line help for the table. Then, whenever the table name appears on a 
list of tables, you or any user can retrieve this help text by pressing [CTRL]-[w]. In 
short, [CTRL]-[n] on the Table Name form lets you define help text, and [CTRL]-
[w] on the Table Selection form displays the help text.
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Defining Help for Columns

As with table help, you can define and display help for columns. In the detail sec-
tion of the Table Name form, press [CTRL]-[n] while the cursor is on a column 
name to display a Note form for that column. In the Note form, you can enter notes 
or help text for the column. Text entered on this form becomes help text and is dis-
played when you or anyone else presses [CTRL]-[w] while the cursor is on the Col-
umn Selection form.

Note

It is recommend that you enter notes for all of your commonly used tables and 
columns. These notes serve as valuable on-line help and assist users in making 
the correct choices when selecting columns for reports.
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Defining Data Groups

Report Writer lets you group related tables into data groups. A data group is a num-
ber of database tables that are related and grouped together under a common name. 
Usually a data group consists of all tables related by some body of data. Data 
groups restrict the data set to a manageable size. By choosing a data group, all 
related tables are automatically retrieved.

Choose the Data Groups option under the Options pull-down menu to display a list 
of the defined data groups. To define a new data group simply select Add a Data 
Group. After you select Add a Data Group, the Define Data Groups form appears. 
This form prompts you for the name of the new data group. The bottom half of the 
Define Data Groups form contains two columns: Table Description and Table 
Name. In these columns you can enter the names of the tables that you want 
grouped in this data group. A Zoom is available in either column, so you can call up 
a list of tables. Press [TAB] to move between the sections on this form.

Defining data groups speeds the report building process. Without data groups, all 
tables and columns in your database related to the main table for the report are dis-
played on every selection list. Some tables may be related to many tables, which 
can have nothing to do with the report you are creating. Data groups help to limit 
the related tables and columns to only those that you need.
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Defining Groups of Reports

The Group Reports option under the Options pull-down menu lets you group 
reports into logical sets. 

To group reports:

1. Select the Group Reports option under the Options pull-down menu.

The Choose a Report Group list appears.

2. Select the Add a Report Group option.

The Define Report Groups form appears.

3. Name your report group and fill in the names of the reports you want to 
include in this group.

For instance, you might want to create a group named Invoicing, then include 
all the reports you’ve made that pertain to invoicing. This way, you don’t have 
to go through many other reports to get to the report you want.

4. Press [ESC] to store your report group.
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Defining Table Relationships

You can create or modify any database table relationship with Report Writer. This 
is generally a job for your system administrator or database manager. The Relation-
ship option displays a list of tables that are related to each other.

To add your own table relationship, select Add a New Relationship from the Table 
Relationship Form. The Table Relationship form appears, prompting for the "from" 
table and the "to" table. In either of these fields, you can use the Zoom function to 
select tables. After you enter the table names, enter the type of relationship. [1] for 
’1 to 1’, [2] for ’1 to many’, [3] for ’1-0 to 1’ and ’1-0 to many’. Selections [3] and 
[4] allow "outer joins," which relate tables regardless of whether they have columns 
in common. Once you enter this information you can move down to the Column 
Joins Definition form by pressing [TAB].

If you are defining a new join, a prompt warns you prior to removing the old join (if 
there was one) and saving the new one. It is necessary to join at least one column 
from each table.

Note

Defining table relationships should be done only by your database administrator. 
Accuracy is very important! Incorrect relationships can lead to incorrect reports 
or reports that do not run. Do not define or alter table relationships unless you 
are sure of what you are doing.
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Defining Column Joins

You can move to the Column Joins Definition form by pressing [TAB] from the 
Table Relationship form.

This form lets you enter the columns that join the tables. As on the Table Relation-
ship Definition form, a Zoom is available for each column field. Once you select a 
"from" column and a "to" column, press [ESC] to save your changes.

Note

Defining column joins should be done only by your database administrator. 
Accuracy is very important! Incorrect joins may lead to incorrect reports or 
reports that do not run. Do not define or alter table joins unless you are sure of 
what you are doing.
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8
Creating a Complex 
Report

This section shows you how to build a complex report using some of the advanced 
features of the Report Writer. This example builds on the simple example report 
outlined in "Creating a Simple Report" on page 3-1. 

This section covers the following topics:

n Grouping and Sorting Report Entries

n Using Multiple Tables and Joining Tables

n Editing the Report

n Calculating Subtotals
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Creating a Complex Report

The following steps outline the process for creating a more sophisticated report. 
Use this steps as a guide for creating your own reports.

Starting the Report Writer and Loading a Report

You can load a report that you created earlier, such as the Customer Listing report 
created in "Creating a Simple Report" on page 3-1, and add columns, subtotals, and 
different formats to it. The next few steps show you how to load a saved report.

To load a saved report:

1. Type fg.writer at the UNIX prompt. 

This command starts the Report Writer using the standard database. For 
these examples demo tables have been added to the standard database. To 
use these tables, it is necessary to merge them into whatever database you want 
to use for running demos. You can use whatever database you like. The demo 
tables are not merged during installation, and must be added manually. To do 
this, run the mkdemo script on the database you wish to use. The syntax for this 
script is:

mkdemo -dbname database 

2. Choose the Load a Report option under the File pull-down menu.

The Choose a Report list appears.

3. Select Customer Listing.

Creating a Report Format

You may wish to apply a new format to your report. Before you can, you must 
define that format. The next set of steps shows you how to build a new report for-
mat (called Wide 256) and how to apply the new format to your report.
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To create a new report Format:

1. Select Formats under the Options pull-down menu. 

The Choose a Format list appears.

2. Select Add a Format. 

The Report Format form appears.

3. Type Wide 256 in the Report Format field. 

4. Press [ENTER] until you are in the Report Width field. 

5. Type 256 for Report Width. 

6. Press [ESC] to store your format and [DEL] to close the Choose a Format 
list. 
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To apply the Wide 256 Format to your report:

1. Select Main Description under the Report pull-down menu to resize your 
report.

The Report Description form appears.

2. Move to the Report Format field and press [CTRL]-[z] to Zoom. 

The Choose a Format list appears. 

3. Select Wide 256, the format you just created. 
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4. Press [ESC] to accept the new report format.

This format widens your report so the columns fit on one row. 

Adding Columns from Joined Tables

Besides the columns defined in your main table, you can add columns defined in 
tables joined to your main table. For more information about joining columns and 
defining table relationships see "Defining Column Joins" on page 7-8 and "Defin-
ing Table Relationships" on page 7-7.

To add columns to your report from another table:

1. Select the Choose Columns option under the Report pull-down menu.

The Choose the Columns list appears.
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The columns you see in this list are from the Customer table, which was speci-
fied as the main table. Zoom on any of the column names in the Choose the 
Columns list to choose columns from other tables joined to the Customer table. 
If there were no other tables joined to the Customer table, you would not see 
any more column names by Zooming. However, we have created joins between 
the Customer table, Orders table, and Items table. For more on joins, see 
"Defining Column Joins" on page 7-8.

When you Zoom on a column name, the Choose a Data File (table) list appears.

2. Select Order Line Items. 

The Choose Columns list appears.

3. Select Line Extension.

An asterisk appears next to Line Extension.

4. Press [ESC] to indicate that you are done choosing.

The Choose the Columns list reappears. 

5. Press [ESC].
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The Arrange Columns form appears.

Arranging Report Columns

You can change the sequence in which columns appear on your report. Rearranging 
the sequence lets you look at information in different ways, and it can help you 
organize and highlight the most important data on your report.

To arrange the columns on your report:

1. Move the cursor down to Line Extension.

The Line Extension column, taken from the Orders table, contains the order 
amount for each customer. The sequence number (11 in this case) should be 
highlighted. 

2. Type the number 1 in the highlighted field, then press [ENTER].

This places Line Extension first in the sequence of columns. 
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3. Press [ESC] to store the change. 

Choosing the Columns to Group by

You can make the information on your reports more clear, if you group it by col-
umns. As the next steps show, this report is grouped by the Customer Number and 
Zip Code columns.

To select columns to group by:

1. Select Group and Sort under the Report pull-down menu. 

2. Select Customer Number and Zip Code. 

An asterisk appears in front of the column names.

3. Press [ESC] to indicate you are done selecting. 

The Group and Sort form appears.

4. Press [ENTER] to accept the sequence.
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5. Type an A in the Sort? field.

An A indicates ascending order. You can specify ascending or descending 
order.

6. Press [ENTER]

7. Type a Y in the Group? field. 

A Y indicates you want to group by Customer Number. 

8. Press [ENTER] to accept. 

9. Press [ENTER] to accept the N default in the Page Bk. field.

10. Press [ENTER].

This indicates that you accept the sequence of Zip Code. 

11. Indicate an ascending sort, and no grouping in the Zip Code row. 

The form should look like the following figure when you are done.

12. Press [ESC] to store your changes. 

Calculating Subtotals on a Column

Many times data contains numeric values you want to calculate subtotals for. You 
can pick any numeric columns to subtotal. Subtotals appear at the end of a group of 
data.
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To specify a column to calculate a subtotal for:

1. Choose Arrange Columns under the Report pull-down menu. 

2. Move the cursor over to the Total? column for Line Extension by pressing 
the [ENTER] key. 

3. Type a Y in the Total? field for Line Extension.

This indicates you want to total this column.

4. Press [ESC] to store your changes.
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Using the Report Editor

After the Report Writer constructs your report, you can use the Report Editor to 
alter a value or a column description. As the following steps show, you can use 
editing keys to make manual changes to your report.

To use the Report Editor to rename the Line Extension column:

1. Select Edit the Report under the Report pull-down menu. 

The report page is displayed, with the cursor in the upper left corner. 

2. Using the arrow keys, move the cursor to the beginning of the word Exten-
sion. 

3. Type Order Amount over Line Extension.

4. Press [ESC] to save your changes.

Printing Your Report

When you finish making manual changes to your report, you can print it. Use the 
Print option under the File pull-down menu to print your report. The following page 
contains output for the report created in this example.



Fitrix Report Writer User Reference

8-12 Creating a Complex Report



A-1

A
Report Writer 
Tables

This appendix contains the names of the tables and columns found in the Report 
Writer. This information is provided for the developer or support person, and is not 
significant to the average user of the system.

cgddgrpd data group list

data_desc char(30) # data group name 

tabname char(18) # table in data group 

grp_order smallint # relative order of table

language char(3) # language key 

index i1ddgrpd on cgddgrpd (data_desc)
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cgxjoinr table join reference

join_id serial 
not null

# join key 

from_tab char(18) # join from this table 

to_tab char(18) # join to this table 

join_type smallint # 1 to 1 or 1 to many

tab_order smallint # relative order for this from table

jn_filter char(100) # additional SQL join criteria

index i1xjoinr on cgxjoinr (from_tab)

cgxsselr selection set reference

selname char(30) # selection set name 

tabname char(18) # main selection set table 

usrname char(20) # selection set creator 

grpname char(30) # data group for the selection set 

date_created date # date created 

date_modified date # date modified 

time_lastused integer # time last used 

sel_status char(1) # status (unused) 

index i1xsselr on cgxsselr (tabname)

index i2xsselr on cgxsselr (usrname)
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cgxsseld selection set elements (detail)

selname char(30) # selection set name 

tabname char(18) # member element, table name 

colname char(18) # member element, column name 

seldata char(200) # selection criteria 

asc_desc char(1) # ascending/descending sort flag 

seqno smallint # sequence for sort and select 

index i1xsseld on cgxsseld (selname, colname)
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cgrreptr report description reference

rptname char(30) # report name 

tabname char(18) # main table 

rpt_width smallint # report page width 

rpt_length smallint # report page length 

rpt_top smallint # number of lines in top margin 

rpt_bottom smallint # number of lines in bottom margin 

rpt_right smallint # number of columns in right margin 

rpt_left smallint # number of columns in left margin 

grpname char(30) # data group for the report 

usrname char(20) # report author 

date_created date # date created 

date_modified date # date modified 

time_lastrun integer # time stamp when last 

run dflt_select char(30) # default selection set for report 

last_select char(30) # last selection set run with report

rpt_printer char(20) # default report printer 

rpt_status char(1) # status (private/public) 

rpt_type char(30) # format style (mailing label,etc)

rpt_manual smallint # manual report vs. automatic 

index i1rreptr on cgrreptr (rptname)

index i2rreptr on cgrreptr (usrname)
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cgrfldsd report cell detail

rptname char(30) # report name 

tabname char(18) # member cell table (if any) 

colname char(18) # member cell column (if any) 

col_order smallint # relative cell order in block 

col_len smallint # cell display length 

col_ypos smallint # cell row position in block 

col_xpos smallint # cell column position in block 

col_attr char(30) # cell attribute (unused) 

col_subt char(1) # subtotal flag 

col_area smallint # report block for this cell 

col_format char(30) # data format in cell 

col_type char(20) # cell type 

index i1rfldsd on cgrfldsd (rptname, colname)

cgrsubgd report primary order and break data

rptname char(30) # report name 

colname char(18) # order/break column 

tabname char(18) # order/break table 

dflt_ord char(1) # default ascending/descending 

seqno smallint # relative order precedence 

subg_flag char(1) # break for subtotals? 
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subg_stat char(1) # status (unused) 

index i1rsubgd on cgrsubgd (rptname, colname)

cgrimged report block image table

rptname char(30) # report name 

rpt_area smallint # report block ID 

line_no smallint # image text line number 

imge_line char(132) # image text 

index i1rimged on cgrimged (rptname, rpt_area)

cgxntabr system table exclusion list

tabname char(18) # table to exclude from table menus 

index i1xntabr on cgxntabr (tabname)

cgrsubgd report primary order and break data
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cgxquryr SQL query table

rptname char(30) # report name 

scrname char(30) # screen name 

selname char(30) # selection set 

usrname char(20) # creator 

runtime integer # time stamp when last used 

qry char(4000) # SQL query text 

qry_type smallint # query type (e.g., count vs. select) 

index i1xquryr on cgxquryr (rptname)

index i2xquryr on cgxquryr (scrname)

index i3xquryr on cgxquryr (selname)

cgrarchr report archive header

rpt_id serial not null # archive unique id for report 

rptname char(30) # report name 

tabname char(18) # main table name 

selname char(30) # selection set name 

grpname char(30) # data group name 

usrname char(20) # name of user who ran report 

daterun date # date report was run 

timerun char(5) # time report was run 

systime integer # systime stamp of report runtime 
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qry_row integer # rowid of report query in cgxquryr 

index i1rarchr on cgrarchr (rptname)

index i2rarchr on cgrarchr (usrname)

cgrarchd report archive text detail

rpt_id integer # archive id for report 

line_no smallint # line number of text 

text_ln char(256) # report text 

index i1rarchd on cgrarchd (rpt_id, line_no)

cgrmathr complex math table

math_id serial not null # unique id for joining math formula to field

math_fmla char(200) # complex math expression for computed field

index i1rmathr on cgrmathr(math_id)

cgrarchr report archive header
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B
Glossary

Boolean Operators: The "and" and "or" operators that are used with comparison 
operators in building a selection clause in the selection criteria option.

Column: In a relational database (the Informix database is a relational database) 
each file is a table organized into rows and columns. A column stores one type of 
information, such as a customer’s name or street address.

Comparison Operators: Operators used with selection criteria to build a selec-
tion clause. Together, they determine the data that appears in your column.

Data Group: A group of database tables that are related and grouped together 
under a common name. Usually a data group contains all tables that contain part of 
some related body of data. Data groups restrict the data set to a manageable size.

Data Set: The extended group of tables and columns that is accessible for the cur-
rent report environment. A data set, which is defined by a primary table, is 
expanded by table relationships stored in the database to include all columns from 
all related tables no matter how indirectly related they are.
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Selection Set: Contains selection criteria for a data set and are applied to a report 
at run time to restrict the set of data selected for a report. You may define any num-
ber of selection sets for a data set.

Main Table: Table that defines the data a report is based on and determines the 
data set, which subsequently determines the selection sets that may be used with the 
report.

Order by Column: Order by column refers to the order in which information is 
sorted on a report.

Table Joins: Statements that determine how tables are related to each other.
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Index

Symbols
! 2-4
$faxnum 5-6
$fg

setting 2-3
$PATH

setting 2-3
$rpt_mailcmd 5-6
* 4-10
... 2-4
>> 2-4
[CTRL]-[n] 4-8, 4-25, 7-3
[CTRL]-[w] 4-3, 4-25, 6-18, 7-3
[CTRL]-[z] 2-9
[TAB] 7-3
{ 6-9

A
A1 Tag 6-7
Acknowledgments

viewing of 2-10
After Group 6-7
Alignment, Printing 5-5
Archive to Database 5-5
Asterisk, Preceding Columns 4-10

B
B1 Tag 6-7
Before Group 6-7
Blank Tag 6-7
Blocks, Report 6-6
Boolean Operators

definition B-1

C
Center Justification 6-12
Choose a Destination List 5-4

archive to database option 5-5
create data table option 5-6
data selection option 5-6
display to screen option 5-7
export data option 5-5
fax option 5-6
mail option 5-6
reporting options option 5-5
write to file option 5-5

Column Detail Zoom
column name field 6-12
format field 6-12
hidden? field 6-13
using 6-12

Column Label 7-3
Column Name 7-3
Column Type

database column 6-9
grand total value 6-10
hidden 6-11
subtotalled value 6-9

Columns
adding 6-8
arranging 4-12, 8-7, 8-10
asterisk preceding 4-10
automatic formatting 6-2
choosing 4-10, 8-5
definition B-1
formatting 6-12
grouping 4-16
help, defining 7-4
hidden 6-11
hiding 6-13
joins, defining 7-7, 7-8
labelling 7-3
layout 6-2
naming 7-2
sorting order 4-14
subtotalling 4-16
totalling 4-13

Comparison Operators 4-21
case sensitivity 4-22
character 4-21
date 4-21
definition B-1
numeric 4-21

Computed Value
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constant value 6-10
math formula 6-10

Constant Value 6-10
Creating New Report 5-2
Cut and Paste a Line 6-6

D
Data File

choosing 8-6
Data Group

choosing 4-2
definition B-1
deleting 6-17
report description form 4-6

Data Groups
defining 7-5

Data Set
definition B-2

Database Column 6-9
Date of Printing 6-11
Defining Help

columns 7-4
report level 4-8
selection set 4-25
tables 7-3

Delete Pull-Down Menu 6-17
data groups option 6-17
description 2-7
formats option 6-17
grouped reports option 6-17
old reports option 6-17
printers option 6-17
relationships option 6-17
selection sets option 6-17

Demo Tables 8-2
loading 2-3

Display Report 5-7

E
Editing

columns, adding 6-8
line, cutting and pasting 6-6
report blocks, adding 6-6, 6-8
report layout 6-4

WYSIWYG 6-4
Ellipse 2-4
Email Report 5-6
Example Report

complex 8-1
simple 3-2

Exclamation Point 2-4
Exit 5-10
Export Data 5-5
Export Report 5-9

F
Fax Report 5-6
fg.runner 5-7
fg.writer 2-3
File Pull-Down Menu 5-1

description 2-6
exit the program option 5-10
import/export option 5-9
load a report option 5-3, 8-2
new report option 5-2
print report option 5-4, 8-12
save the report option 5-8

First Row 6-7
Flushleft 6-12
Form

arrange columns 4-12, 6-2, 8-7
column joins defining 7-7
define report groups 6-16
group and sort 4-15
help 6-18
report description 4-6, 8-4
report help 4-8
selection set note 4-25
sorting and data selection columns 4-20
table help 4-3
table name 7-2
table relationship 7-7

Format, Column 6-12
Format, Report 4-5
FR Tag 6-7

G
Grand Total Value 6-10
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Greater Than Symbols 2-4
Group and Sort Form 4-15

column field 4-15
group? field 4-15, 8-9
page bk. field 4-15, 8-9
seq field 4-15
sort? field 4-15, 8-9

Group, Data 4-2

H
HD Tag 6-6
Header 6-6
Help

[CTRL]-[w] 4-3
columns, defining 7-4
help pull-down menu 2-8
on-line, using 6-18
selection set, defining 4-25
selection set, viewing 4-25
table help form 4-3
table, defining 7-3

Help Pull-Down Menu 6-18
description 2-8

Hidden Columns 6-11
Hiding Columns 6-13

I
Import Report 5-9

J
Joins

column joins definition form 7-7
definition B-2
outer 7-7

Justification
center 6-12
flushleft 6-12
left 6-12
pushleft 6-12
pushright 6-13
right 6-12

L
Last Row 6-7
Layout, Report 6-2, 6-4
Left Justification 6-12
List

choose a column type 6-9
choose a data group 4-2
choose a destination 5-4
choose a format 8-4
choose a report 5-3
choose a report group 6-16
choose a selection set 5-4, 5-6
choose the sorting columns 4-14
report format 4-5
select an option 5-5
selection set 4-20

Loading a Report 5-3
current report 5-3
last report 5-3

LR Tag 6-7

M
Main Table

definition B-2
selecting 4-3

Math Formula 6-10
Menu Options

help form 6-18
report writer 2-6
screen pager 3-7

Menus
! preceding option 2-4
... following option 2-4
>> following option 2-4
delete pull-down 2-7
file pull-down 2-6
help pull-down 2-8
options pull-down 2-7
pull-down 2-4
quit pull-down 2-8
report pull-down 2-6
unavailable option 2-4
using 2-4

mkdemo 2-3, 8-2
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mklib 2-3
mkwriter 2-3

N
New Report 5-2

O
On Every Row 6-7
On-Line Help

[CTRL]-[w] 4-3
columns, defining 7-4
info option 6-18
quit option 6-18
report level, defining 4-8
selection set, defining 4-25
selection set, viewing 4-25
table help form 4-3
table, defining 7-3
update option 6-18
using 6-18
view option 6-18

Options Pull-Down Menu
add a format option 6-14
data groups option 7-5
description 2-7
formats option 4-5, 8-3
group reports option 6-16, 7-6
printers option 6-15
relationship option 7-7
table/columns option 7-2
update printers option 5-5

Order, Column Sort 4-14
definition B-2

P
Page Breaks 4-15, 4-18

after group 4-18
before group 4-18

Page Number 6-10
Page Trailer 6-8
Pager, Screen 3-7
Print Report 5-4

archive to database 5-5

command line 5-7
destination, choosing 5-4
displaying to screen 5-7
export data 5-5
faxing option 5-6
form alignment 5-5
reporting options 5-5
sending by email 5-6
storing in data table 5-6
summary only 5-5
test length 5-5
write to file 5-5

Printers
adding 6-15
defining 5-5
deleting 6-17
updating 5-5

Private Report 4-7
Pushleft 6-12
Pushright 6-13

Q
Quit 5-10

pull-down menu 2-8

R
Relationship

1 to 1 7-7
1 to many 7-7
1-0 to 1 7-7
1-0 to many 7-7
deleting 6-17
table relationship form 7-7
table, defining 7-7

Report
archiving to database 5-5
command line, printing 5-7
current report 5-3
deleting 6-17
describing 4-6
displaying 5-7
editing 6-2
emailing 5-6
exporting 5-9
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exporting data 5-5
faxing 5-6
format, choosing 4-5
grouping 6-16
importing 5-9
last report 5-3
layout, building 6-2
layout, editing 6-4
loading 5-3
naming 4-6
printing 5-4
private 4-7
saving 5-8
simple example, building 3-2
writing to file 5-5

Report Blocks 6-6
A1 tag 6-7
adding 6-8
B1 tag 6-7
blank tag 6-7
FR tag 6-7
HD tag 6-6
identifier tags 6-6
LR tag 6-7
TR tag 6-8

Report Description Form 4-6, 8-4
data group field 4-6
private report field 4-7
report format field 4-7, 8-3
report name field 4-6
report width field 8-3
selection set field 4-7
table field 4-7
table name field 4-7

Report Editor 6-4
blocks, adding 6-6
column detail zoom, using 6-12

Report Formats 4-5
deleting 6-17
updating 6-14

Report Groups
defining 6-16, 7-6
deleting 6-17

Report Layout 6-2
Report Pull-Down Menu

arrange columns option 6-2, 8-10
choosing columns option 8-5

description 2-6
edit the report option 6-2, 6-4, 8-11
group and sort option 4-14, 8-8
main description option 4-6, 8-4
selection sets option 4-20

Report Runner 4-19, 5-5, 5-7
fg.runner 5-7
starting 5-7

Report Title 6-11
Report User Name 6-11
Report Writer

general overview 2-2
menu options 2-6
quitting 5-10
starting 2-3
tables A-1

Right Justification 6-12
Row Count 6-11
Row Number 6-11
Runtime Report Value 6-10

S
Save Report 5-8
Screen Pager 3-7
Selection Criteria

boolean expression 4-22
building of 4-21
comparison operators 4-21

Selection Set
choosing 5-4, 5-6
defining 4-19
definition B-2
deleting 6-17
help, defining 4-25
report description form 4-7
selection set note form 4-25

Selection Set Name 6-11
Sort Order 4-14

columns 4-14
definition B-2

Sorting and Data Selection Columns Form 4-20
column field 4-20
selection data field 4-20
sequence field 4-20
sort field 4-20

Special Value 6-10
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date of printing 6-11
page number 6-10
report title 6-11
report user name 6-11
row count 6-11
row number 6-11
selection set name 6-11
time of printing 6-11

SQL Query
building manually 4-24
building of 4-19
statements 4-22
syntax 4-22

Starting Report Writer 2-3
fg.writer 2-3

Subtotalled Value 6-9
Subtotalling 4-16
Summary, Printing 5-5

T
Table

choosing 8-6
data 5-6
familiar name 4-7
help, defining 7-3
joins, definition B-2
main 4-3
main, definition B-2
naming 7-2
relationship, defining 7-7
report writer A-1
technical name 4-7

Table Help Form 4-3
Tags

A1 6-7
B1 6-7
blank 6-7
FR 6-7
HD 6-6
LR 6-7
TR 6-8

Termcap
compatibility 2-3

Time of Printing 6-11
Totalling 4-13
TR Tag 6-8

U
Update 6-18

V
Variables

$faxnum 5-6
$fg 2-3
$PATH 2-3
$rpt_mailcmd 5-6

W
Write to File 5-5
WYSIWYG 6-4

Z
Zooms

[CTRL]-[z] 2-9
choose a column list 8-6
column detail 6-12
report description form 4-7, 8-4
sorting and data selection columns form 4-21
table relationship definition form 7-8
using 2-9
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